Gathering Existing Building Conditions for Performance Analysis when Documentation is not Available

This tutorial demonstrates how to create a basic energy model from a series of digital photographs.

Every day, buildings use substantial amounts of energy, water, and raw materials, creating a sizeable environmental footprint. The government mandates are clear: buildings must become more energy-efficient and environmentally friendly. Because you need to evaluate the performance of and proposed modifications for dozens – if not hundreds or thousands – of buildings, your review process must be practical, repeatable, and scalable. Building Information Modeling (BIM) provides the basis for such analysis.

Whether you’re a member of an architecture or engineering firm, a government energy, facility, design, or construction department, or an energy service company, using BIM to develop a basic 3D model for existing buildings allows you to quickly perform an initial energy analysis and compare the energy efficiency of buildings. And because a basic model can be built using a few key building dimensions, you can create the first model in just a few hours. This cost effective approach makes BIM a perfect tool for developing and evaluating energy plans for even the most unwieldy portfolio of heterogeneous, geographically-dispersed buildings.
Table of Contents

Purpose 3
About the Autodesk Products in this Tutorial 3
  Autodesk® ImageModeler™ 3
  Autodesk® Revit® Architecture 3
  Autodesk® Revit® MEP 3
  Autodesk® Ecotect™ Analysis – Web Service Platform 4
Gathering Existing Conditions with Autodesk ImageModeler 4
  Photographing the Building 4
  The ImageModeler User Interface 5
  Loading Images 6
  Calibrating Cameras 7
  Applying Scale: Define a Reference Distance 10
  Define a Coordinate System 11
  Create 3D Model Geometry 13
  Exporting data 16
Developing an Energy Model using Revit Architecture or Revit MEP 17
Uploading the gbXML file to Ecotect Analysis – Web Service Platform 19
Interpreting Results 21
  Estimated Energy and Cost Summary 22
  LEED® Glazing Score 22
  Natural Ventilation Potential 23
Tips for Getting Great Results 23
  Beyond Ecotect Analysis – Web Service Platform 23
  Face or Surface Normals 23
  Finding the Right Level of Detail 24
Additional Information 26
Purpose
This tutorial demonstrates how to create a basic building model suitable for performing energy analysis when access to existing condition documentation is not available. It assumes the following levels of experience and familiarity with each tool:

- ImageModeler: Low
- Revit Architecture or Revit MEP: Medium
- Ecotect Analysis Web Service: Medium

The process begins by capturing digital photographs of the existing building. Next, the photographs are converted into 3D Geometry using photogrammetry technology in Autodesk ImageModeler. The resultant geometry is transferred, via DWG, to Revit Architecture or Revit MEP where real world building components are modeled using the geometry as a guide. Finally, the analysis data contained in the Building Information Model is transferred, via gbXML, to the Autodesk Ecotect Analysis – Web Service for whole building energy analysis. While this tutorial concludes with the Ecotect Analysis – Web Service, Revit data can similarly be moved into other Autodesk analysis tools, such as Autodesk® Ecotect™ - Desktop Tools, and to other popular industry tools such as the US Departments of Energy’s eQuest® software.

About the Autodesk Products in this Tutorial

Autodesk® ImageModeler™
Autodesk ImageModeler image-based modeling and photogrammetry software generates 3D models from 2D digital images, giving architects and designers a new approach to 3D modeling. Bridging the 2D and 3D worlds, ImageModeler enables you to capture the reality as-built, take measurements of buildings, and easily create photorealistic 3D models. Editing, modeling, and texturing tools help you to further edit, refine, and texture your rendered objects. Your 3D objects can then be exported into different formats. For more information, including a 30 day trial*, visit www.autodesk.com/imagemodeler.

Autodesk® Revit® Architecture
Autodesk Revit Architecture software helps you explore early design concepts and forms, and more accurately maintain your vision through design, documentation, and construction. Make a change, and it’s automatically updated across the project. Use the essential building information modeling (BIM) data that Autodesk Revit Architecture software provides to support sustainable design, clash detection, construction planning, and fabrication. For more information, including a 30 day trial*, visit www.autodesk.com/revitarchitecture.

Autodesk® Revit® MEP
Autodesk Revit MEP software is the building information modeling (BIM) solution for mechanical, electrical, and plumbing (MEP) engineers, providing purpose-built tools for building systems design and analysis. Using Autodesk Revit MEP, collaboration is easier among building system design team...
Gathering Existing Building Conditions for Performance Analysis

members, architects, and structural engineers, helping to minimize building design coordination errors. For more information, including a 30 day trial*, visit www.autodesk.com/revitmep.

Autodesk® Ecotect™ Analysis – Web Service Platform
Autodesk Ecotect Analysis green building software is a comprehensive sustainable analysis tool that delivers a wide range of simulation and analysis functionality through desktop and web-service platforms. Powerful web-based whole-building energy, water, and carbon analysis capabilities converge with desktop tools to conduct detailed environmental simulations and visualize results.

The Ecotect Analysis Web Service is also known as Autodesk® Green Building Studio® web service. Green Building Studio is available to Subscription customers of Autodesk Ecotect Analysis software during the term of their subscription. Ecotect Analysis Web Service can help architects and designers perform whole building analysis, optimize energy efficiency, and work toward carbon neutrality earlier in the design process. With faster, more accurate energy analysis of building design proposals, architects and designers can work with sustainability in mind earlier in the process, plan proactively, and build better. For more information, including a 30 day trial*, visit www.autodesk.com/ecotectanalysis.

*This offer is valid only in the United States and Canada. For countries outside the United States and Canada, contact your local Autodesk Authorized Reseller. This service is subject to the web service terms of use that governs use of this service.

Gathering Existing Conditions with Autodesk ImageModeler

Photographing the Building

- **Choose shots that provide complete coverage of the buildings’ surfaces.** If part of the building is masked in one image, make sure that you include another image that reveals the masked region.

- **Choose shots that show good perspective and adequate spatial information,** rather than those that show only one side of the building. ImageModeler gets the depth information of an object from the perspectives shown in the photographs. Often, the best photos are taken from an elevated vantage point. The triangulation process in ImageModeler requires each point of commonality for reference must be seen from at least two photos with sufficient viewing angle between the two (ideally, 45° to 90°). To be even safer, one way to get good data in most cases is to make sure that each corner of your building is seen from at least 3 photos with sufficient viewing angle between the three.

- **Choose shots that are in focus and are well lit.** Sharp images produce visible detail, making it easier for you to create models that look more realistic.

- **Choose shots that have the same zoom lens setting.** If you use a constant zoom, the focal length is more constrained than when you use a zoom and ImageModeler finds the focal length of the image more precisely.

- **Choose shots that include physical markers in the scene.** Using shots with easy-to identify reference points both on the building you want to model and in the space surrounding the subject in the calibration and modeling processes.
Gathering Existing Building Conditions for Performance Analysis

- **Avoid choosing cropped images or images that have been modified** in an external graphics package because they introduce uncontrolled changes of the distortion correction, the principal point, and the focal length of the image.

For more information on taking and choosing the best photographs, search for *How to Take Quality Shots* in the ImageModeler Help Files. Here are the three digital photographs that are referenced in this tutorial.

The ImageModeler User Interface

The ImageModeler User Interface is comprised of seven key components. The 3D Workspace is where you do most of your work, including calibrating cameras, modeling objects, and extracting textures. When a tool is selected, its properties will display in the Tool Properties area. Tools that change the display for objects and components in the 3D Workspace are contained within the Display Toolbar. The Scene Browser allows you to track and change properties for camera shots and camera devices, view locators, select and edit objects and materials. Finally, the Thumbnail View only appears when working with a single viewport in a project that has multiple images. It can be
shown or hidden by using the open and close arrows on the bottom right of the 3D Workspace, and you can change the horizontal position of the Viewer by dragging it left or right.

The Workflow Toolbar contains a set of contextual toolbars for working through the ImageModeler workflow (Loading, Calibration, Measuring, Modeling, Texturing, and Exporting). They are arranged from left to right and mirror the intended ImageModeler workflow.

**Loading Images**
After creating a new project, the first step is to load images into a project.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>On the <em>Loading</em> workflow tab, choose <em>Multiples</em> from the pull-down menu and then click the <em>Add Image(s)</em> button.</td>
<td>The <em>Load Images</em> dialogue will open.</td>
</tr>
</tbody>
</table>

*Notes:* The primary function of this dialogue is to add and/or remove images from the active project. Projects can include images captured with varying digital cameras and lenses. In most cases, ImageModeler will automatically determine the type of camera and lens that was used to take the photograph. However, advanced users are free to import camera and lens data specified by .LENS data files.

| 2.   | In the *Load Images* dialogue, click the *Add Images* button. | Images will be organized in the *Shots* folder in the *Scene Browser*. |

The browser dialogue will open. Browse to, select the images, and
Calibrating Cameras
In ImageModeler, calibration orients the 3D space for your model from the 2D images that were used to capture the photographs. Calibration is an essential step in the ImageModeler workflow and must be completed successfully before beginning to create any 3D model geometry. Carefully calibration is an important step upon which all subsequent stages rely.

Calibration is the act of identifying consistent features among different photographs. Based on the parameters of the camera (position, rotation, focal length, and distortion), ImageModeler can help calculate the 3D coordinates for defined features. Features are defined by placing **Locators** in the images. Locators should be placed on distinct and easily identifiable features, such as a corner of the building or window sill, that are visible in at least three photographs. For the process of calibration, Locators do not need to be placed on the building. Placing a locator on off of the building, such as a street lamp or automobile, will help ImageModeler as the spatial orientations of the locators are more dispersed.

The number of locators that is needed for any project will vary based on the size of the project, the complexity of the scene to reconstruct, and the accessibility of points in all or several photographs. There is no rule stating how many locators are required, but ImageModeler will not complete the calibration with less than eight common locators on two images and at least four locators on the rest of the images. Optimally, eight to twelve targets in each image can be enough. However, more locators may be required. Continue placing locators until ImageModeler displays the **Calibration Successful** dialogue. For additional information regarding calibration, browse for **Calibrating Cameras in Multiple-Image Projects** in the Content Files which can be accessed through the Help pull-down Menu.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>On the <strong>Calibration</strong> workflow tab, click the <strong>Create/Move Marker</strong> tool.</td>
<td>A locator is added to the Scene Browser.</td>
</tr>
</tbody>
</table>
### Gathering Existing Building Conditions for Performance Analysis

#### 2(a).
Identify the first point of commonality across three images. Hover the mouse over the point then press and hold the left mouse button.

*Note: while in the 3D Workspace, press the space bar to toggle between single and four viewport views.*

A enlarged thumbnail will display and allow for finer adjustment of location.

#### 2(b).
In the enlarged thumbnail, refine the location of the mouse target. Once the target is positioned over the point of commonality, release the left mouse button.

A locator persists in the image.

#### 3.
With the marker tool still active, switch to the second image where the point of commonality is visible. Hover the mouse over the point then press and hold the left mouse button.

A Locator Persists in the image.
| | In the enlarged thumbnail, refine the location of the mouse target. Once the target is positioned over the point of commonality, release the left mouse button.  

*Note: A white target indicates the placement of the second or third locator (of three) for a point of commonality.*

| 4. | With the marker tool still active, switch to the third image where the point of commonality is visible. Hover the mouse over the point then press and hold the left mouse button.  

*In the enlarged thumbnail, refine the location of the mouse target. Once the target is positioned over the point of commonality, release the left mouse button.*  

*Note: If the Create/Move Marker tool is exited for any reason and the three locators for a point of commonality are not placed, simply click the Locator in the Scene Browser to restart the tool.*  

| 5. | Repeat steps one through four until ImageModeler reports that it has calibrated the model. A dialogue box will open and report the success. |

---

**ImageModeler**

Calibration successful

**OK**
Gathering Existing Building Conditions for Performance Analysis

Note: Once Calibrated, the Scene Browser will update. Images and Locators that are highlighted green indicate a well calibrated image and locator. Similarly, yellow indicates weak calibration while red indicates poor calibration.

Note: Once calibrated, locators can be defined within the model by only identifying a commonality across only two images.

Applying Scale: Define a Reference Distance
When shooting your photographs, measurement of any object in the real world must be taken to standardize the virtual coordinate system used by ImageModeler. To initialize the scale of a scene, you should capture a standard measurement while shooting the images. The standard measurement can be, for example, as rudimentary as a door’s or window’s width or height.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>If not already done, create a Locator at either end of the reference measurement using the same method described in the Calibrating Cameras section steps one through four.</td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>On the Calibration Workflow Toolbar, click the <strong>Define Reference Tool</strong>.</td>
<td></td>
</tr>
<tr>
<td>3(a).</td>
<td>Hover over the first Locator of the reference measurement, and click</td>
<td></td>
</tr>
</tbody>
</table>
to select the locator. The cursor should snap to the locator.

Note: You can change the units settings by clicking Edit > Preferences and then selecting the Measurement Preferences.

3(b). Hover over the second Locator of the reference measurement, and click to select the locator.

3(c). Enter the length of the Reference Distance in the Tool Properties and then click Apply.

A dimension is placed displaying the Reference Distance.

Note: Dimensions can now be pulled off of the model. Simply click the Add Distance Ruler on the Measuring tab and select two locators. A new dimension will be added to the model and Scene Browser.

Define a Coordinate System
After calibration, you can define the 3D space, or “world space” in which you will create, evaluate, and modify your models. World space orientation is defined by the X-, Y-, and Z-axis of the XYZ Indicator in the lower left corner of a viewport:

In addition to width, height, and depth, the XYZ axes also indicate direction (right, left, up, down, higher, lower) and provide a reference point for measuring the size and precise location of an object.
Gathering Existing Building Conditions for Performance Analysis

in the world space. Many 3D packages, including ImageModeler, assign an arbitrary point in space as the point of origin of the X-, Y-, and Z-axes. This point of origin has a coordinate value of (0, 0, 0): the exact point at which the three axes meet.

The **World Space Tool** is used to define the origin and the main axis (X, Y, Z) of the coordinate system of your scene. The tool is composed of a direct trihedron (three orthogonal axes):

- The origin represents the point in the 3D space from where all coordinates will be calculated.
- The pivot handles near the origin of the tool allow you to separate the definition of the axis from the origin point. This is useful when you cannot or do not want to place all axis starting from one unique origin.
- The extremity handles allow you to define the world coordinate system. To set the origin and the axes of the world space, choose characteristic points in the images that define a trihedron (almost right angles between each edge) and create 3D locators from these 2D points.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>On the <strong>Calibration</strong> Workflow Toolbar, click the <strong>Define World Space</strong> button.</td>
<td>![Image of the World Space Tool]</td>
</tr>
<tr>
<td>2.</td>
<td>Drag the <strong>point of origin</strong> toward the locator to which you want it to snap. The Snap tool is automatically enabled, allowing you to snap to locators created from 2D markers. When the pointer is snapped to the locator, release.</td>
<td>![Image of a point being snapped]</td>
</tr>
<tr>
<td>3.</td>
<td>Next, click and drag an extremity handle toward another locator that</td>
<td></td>
</tr>
</tbody>
</table>
points the extremity in the proper direction. In this example, the Z axis is indicating ‘up’.

*Note:* The ImageModeler World Space should be set to coincide with Revit-based applications. In Revit-based applications, Z is ‘up’.

4. Click and Drag the second extremity handle toward a second locator to lock in the second axis. In this example, the Y axis is indicating north.

5. The world coordinate system is now set. The position of the remaining axis that you have not set is imposed by the coordinates of the first two axes and the origin. In the above example, the X axis is determined by the position of the Z and Y axes and the origin.

---

**Create 3D Model Geometry**

To begin modeling in ImageModeler, 3D model geometry is created by snapping primitive shapes to predefined locators or other geometric edges and corners. The primitive shapes that are available inside of ImageModeler are plane, cube, cylinder, sphere, and circle. As such, additional Modeling Locators may need to be placed. More advanced tools are also available on the Modeling Workflow Tab and Tool Properties Bar. For additional help, search for *Modeling* in the ImageModeler Getting Started Guide. Be sure to pay close attention to the Create Face, Split Face, and Extrude tools.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>On the <strong>Modeling</strong> Workflow Toolbar, click the <strong>Place Modeling Markers</strong> button. Place Modeling Markers to identify commonalities among photographs that will be used to snap primitive geometry. Repeat this process as often as</td>
<td>Modeling Markers are added to Scene Browser.</td>
</tr>
</tbody>
</table>
Once sufficient Modeling Markers have been created to support the creation of a primitive, it is time to start building geometry.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Click the Create Primitive button on the <strong>Modeling</strong> Workflow Tab.</td>
<td><img src="image1.png" alt="Create Primitive" /></td>
</tr>
<tr>
<td>2.</td>
<td>In the Tool Properties bar, click the desired primitive (e.g. Add Cube)</td>
<td><img src="image2.png" alt="Tool Properties" /></td>
</tr>
<tr>
<td>3(a).</td>
<td>Select the first Locator to begin modeling the cube.</td>
<td><img src="image3.png" alt="Locator" /></td>
</tr>
</tbody>
</table>
Gathering Existing Building Conditions for Performance Analysis

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>3(b).</strong></td>
<td>Select the second Locator to continue the cube.</td>
</tr>
<tr>
<td><strong>3(c).</strong></td>
<td>Select the third Locator to continue modeling the cube.</td>
</tr>
<tr>
<td><strong>3(d).</strong></td>
<td>Select the fourth and final Locator to complete modeling the cube.</td>
</tr>
<tr>
<td><strong>4.</strong></td>
<td>Continue snapping new pieces of</td>
</tr>
</tbody>
</table>
Gathering Existing Building Conditions for Performance Analysis

geometry to locators or the edges and corners of other geometry.

*Note:* A significant variable in Building Performance Analysis tools is the total amount of square footage. As such, be sure to add a piece of geometry that identifies level heights. This elevation is an important identifier to which you will align a floor later in Revit Architecture.

*Note:* Press `ctrl + k` to toggle between Geometry & Photograph views.

Exporting data
The ImageModeler export feature allows you to export files to DWG to transfer geometry to Revit Architecture.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>On the <strong>Export</strong> Workflow Tab, click the Export button.</td>
<td><img src="image" alt="Export Workflow Tab" /></td>
</tr>
<tr>
<td>2.</td>
<td>Click the ... button next to the File Name box. Choose a save destination and file name. Click Save. From the Format pull-down, choose <strong>Autodesk RealDWG 2010 (dwg)</strong>. Click OK.</td>
<td><img src="image" alt="Export Scene As" /></td>
</tr>
</tbody>
</table>
Developing an Energy Model using Revit Architecture or Revit MEP

Creating a building information model is not an overwhelming or onerous task. Even with minimal upfront effort, you can generate a basic model that represents the form and geometry of the building and begin analyzing and prioritizing building improvements. In fact, a relatively simple Revit model, created in about 3 hours, can produce a surprising level of predictability for your building performance analysis. For example, even using the low-detail building model, important results can be attained to help make better decisions about which measures to pursue for the greatest impact on reducing annual energy consumption. Here are a few rules of thumb:

- Use generic elements
- Limit the modeling to major design elements (e.g. walls, doors, windows, openings, floors, and roofs). Do not become encumbered with fine details
- The key purpose of the design elements is to enclose rooms and define non-graphical properties

Both Revit Architecture and Revit MEP contain the functionality required to build more accurate energy models faster. For example, both can create walls, doors, windows, roofs, and floors. For the purpose of energy modeling, the only source of differentiation is the amount and type of data contained in the Room (Revit Architecture) or Space (Revit MEP) object. In Revit MEP, the Space object exposes more properties in order to support the granularity of the engineering workflow. When the Ecotect Analysis – Web Service receives a gbXML from Revit MEP, it pulls the parameter data from within the energy model for the analysis. Conversely, when the Ecotect Analysis – Web Service receives a gbXML from Revit Architecture, it approximates values for the undefined Room properties based on local statistics gathered for the Postal Code of the project.

The following process can be applied in Revit Architecture or Revit MEP.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>In the Project Information dialogue box, enter Energy Data information. This information will be included in the gbXML export for use in the Ecotect Analysis – Web Service analysis results.</td>
<td>![Table Image]</td>
</tr>
</tbody>
</table>
2. Import the ImageModeler Geometry

3. Create Levels and other reference points

4. Starting on the lowest level and using the imported DWG shell as a guide, begin to snap generic building components into place.

Continue adding major building elements until the exterior of the building is complete.

*Note:* When generating an energy model for Ecotect Analysis – Web Service, the material composition of walls, roofs, and floors is more detail than the analysis requires and will interpret. Focus on enclosing Rooms (as they contain the most important information).
### Gathering Existing Building Conditions for Performance Analysis

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>5.</strong></td>
<td>Create and place several Rooms/Spaces that effectively divide the building into major zones. Adjust room/space properties as necessary.</td>
</tr>
<tr>
<td></td>
<td>Ensure that the Rooms/Spaces are assigned the proper vertical constraint.</td>
</tr>
<tr>
<td><strong>6.</strong></td>
<td>Preview the gbXML export and make any edits necessary. Click Export to create a gbXML file.</td>
</tr>
</tbody>
</table>

#### Uploading the gbXML file to Ecotect Analysis – Web Service Platform

The Autodesk Ecotect Analysis – Web Service Platform helps provide rapid, more accurate energy use estimates for your building design within the building information model. It enables
collaborative design, allowing you to share building information with other team members, manage or minimize plan take-off tasks, and transfer essential information about your building design to the applications used for engineering design or code analysis.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a new project.</td>
<td>This process has 6 total steps.</td>
</tr>
</tbody>
</table>
### Interpreting Results

The Ecotect Analysis – Web Service results pages provide more accurate and understandable summary information on building energy and resource use, carbon emissions, simulation assumptions, performance metrics, and costs that can be used to compare the energy costs of multiple building design scenarios at the conceptual design stage.

Once the run is complete, a screen similar to the following will display. Browse through the results by clicking through the result tabs.
Here is a short description of some of the results that the Ecotect Analysis – Web Service presents. For a more complete description go to www.autodesk.com/greenbuildingstudio and then click on the White Papers link. Locate the Using Green Building Studio with Revit Architecture and Revit MEP whitepaper.

Estimated Energy and Cost Summary
Most building energy cost comparisons and early compliance decisions can be made using annualized energy cost and consumption information. Costs are estimated using statewide average utility rates, or the customized rates you may have applied to the project. The following information is provided:

- Annual energy cost
- Lifecycle energy costs (30 year)
- Annual energy consumption (electric and gas)
- Peak electric demand (kW)
- Lifecycle energy consumption (electric and gas)
- CO2 emissions are based on the onsite fuel use and the fuel sources for the electricity in the region.
- An equivalency using an SUV (driven 15,000 miles/year) is given to put the building’s CO2 emissions into perspective.

LEED® Glazing Score
The LEED glazing score is the percentage of regularly occupied floor area that has a Glazing Factor greater than 0.02. Note that the tool assumes the entire floor area of your project to be regularly occupied unless you have defined some spaces through Revit MEP as restrooms, corridors, storage, mechanical rooms, or conference rooms (spaces not considered to be regularly occupied by LEED). The score must be more than 75 percent to score LEED points and achieve full benefit from day lighting controls throughout the building.
Gathering Existing Building Conditions for Performance Analysis

Natural Ventilation Potential
The tool calculates the approximate annual operating hours and energy required to mechanically cool and ventilate the building. It also help estimate the annual number of hours that outdoor air could be used to naturally ventilate the building. Potential energy savings associated with not running the mechanical cooling and ventilation system during this period are projected, and finally, the net hours that cooling is required, even with natural ventilation, are estimated.

Tips for Getting Great Results

Beyond Ecotect Analysis – Web Service Platform
Ecotect Analysis – Web Service provides a gateway to the DOE-2 and EnergyPlus™ file formats. While viewing the analysis results in Ecotect Analysis – Web Service, find the DOE-2 File or EnergyPlus File links on the left side of the browser.

DOE-2 File: This link exports the geometrically precise DOE-2.2 input file that was generated by Ecotect Analysis – Web Service for the energy simulation. It can be used downstream as the starting point for other more detailed engineering analysis. This file can be directly imported into the free eQUEST® DOE-2 application at www.doe2.com.

EnergyPlus File: This link exports the geometrically precise EnergyPlus™ file that was generated by the Ecotect Analysis – Web Service. It can be used as a starting point for more detailed engineering analyses. The EnergyPlus simulation program can be downloaded at www.energyplus.gov.

Face or Surface Normals
During geometry transfer from ImageModeler to Revit Architecture, a surface may appear as though it was deleted or did not transfer.
This is usually the result of an inverted face normal. Face normals indicate the direction of the faces of a polygon. By default, ImageModeler creates face normals that face outward. To verify which way normals are facing, click on the View Normals icon in the Display toolbar. Arrows facing outward or inward indicate which way the faces of a polygon face.

Inverting a face is like turning the object inside out. Select the object and then click Invert Face Normals from the Scene pull-down menu.

Finding the Right Level of Detail
Studies show that comparative results between energy models of low versus high detail differ by only small percentages. Take this into consideration when developing the energy model. Note the comparison of annual electricity usage results below for a low, medium, and high detailed model.
To achieve a higher level of detail, add interior detail by defining each room in the building. Follow the same ImageModeler process but use photographs of the interior spaces.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>By developing a model of medium detail, building analysis will yield a more accurate result.</td>
</tr>
</tbody>
</table>
Additional Information
Additional information regarding the products and the processes described in this workflow are available through www.autodesk.com. Look for these and other white papers:

**BIM and the Autodesk Green Building Studio:** The white paper explores how the Autodesk® Green Building Studio® service allows architects to more easily evaluate the carbon “footprint” of a Revit-based building design using the new Green Building Studio plug-in for Revit.

**Weather Data for Building Energy Analysis:** Autodesk® Green Building Studio® provides a complete year of weather data for design and building energy analysis. With 55,000+ locations, a virtual weather station is no further than 14 km (8.8 miles) from any given project within the contiguous 48 states of the United States. This whitepaper discusses the benefits of using Green Building Studio weather data and provides guidance in choosing a weather station for energy analysis.

**Using BIM for Greener Design:** In this paper, architects use BIM to perform faster and more accurate energy analysis on early stage building designs, thereby promoting the construction of green buildings.

Autodesk, Ecotect, Green Building Studio, ImageModeler, RealDWG and Revit are either registered trademarks or trademarks of Autodesk, Inc. and/or its subsidiaries and/or affiliates, in the USA and/or other countries. All other brand names, product names, or trademarks belong to their respective holders. Autodesk reserves the right to alter product offerings and specifications at any time without notice, and is not responsible for typographical or graphical errors that may appear in this document.

© 2009 Autodesk, Inc. All rights reserved.